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Introduction
IBM® Rational® Change is a generic change request management system that is Web-based 
and integrated with IBM® Rational® Synergy.
The following pages give you the basic information needed to use Rational Change in the Report 
Builder (ReportBuilder) role:

• Taking the Rational Change Report Builder interface tour (page 2)

• Starting Rational Change sessions (page 4)

• Using Help (page 5)
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Introduction
Taking the Rational Change Report Builder interface tour
The Rational Change interface consists of an Action Panel (page 2), a Button Bar (page 3), 
and a Dialog Panel (page 3) that changes when you click an Action Panel button.
The following figure shows the Rational Change window after you have clicked the Report 
Builder button and selected a report.

Action Panel
The Action Panel is the top row in the Rational Change window and is where you start any 
operation (for example, Report Builder). Clicking a button displays the action’s corresponding 
dialog box in the Dialog Panel.
The following actions are available in the Action Panel for users in the ReportBuilder role:

Action Panel

Button Bar

Dialog Panel 
with Report 
Properties dialog 
box displayed
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Taking the Rational Change Report Builder interface tour
 Home button

Click to display the first Rational Change Welcome page.

 Report Builder button

Click to build a Rational Change report using customizable components.

 Help button

Click to display help for your role.

 Exit button

Click to log out of Rational Change. This operation quits the Rational Change session and 
frees the session resources. 

Button Bar

 Help link

Click the Help link on each dialog box button bar to display context-sensitive help.

Other buttons might be visible, depending on the dialog that is displayed.

Dialog Panel
The Dialog Panel is the remaining portion of the Rational Change window and is where dialog 
boxes and the results of most operations are displayed.
The following graphics indicate the operation status:

  A green check mark indicates success.

  A red “X” indicates failure.

  An “i” (“information”) indicates that you should read the results dialog box to determine 
what happened.
If the graphic indicates failure, the accompanying text gives the reason for the failure. If you do 
not know how to correct the failure, contact your Rational Change administrator.
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Introduction
Starting Rational Change sessions
Starting a session requires the following:

• You are running a supported browser

• You have the URL for your Rational Change installation

• Your User ID has at least one of the Rational Synergy roles associated with the Rational 
Change login role you are using.

To start a session:

1. Display a browser.

2. Go to the URL for your Rational Change server.

The URL will be something like http://hostname:port_number/context/user.

For example, http://eagle:8600/change/user

3. In the Rational Change Login window, type your user ID and password.

4. Press Login.

Note For the steps below, you might see slightly different log on 
options, depending on whether you have previously logged on 
to Rational Change.

5. In the Database list, click the database you want to use.

6. In the Role list, click ReportBuilder.

7. Press Connect.
The Rational Change window appears. The Action Panel (page 2) is the small frame at the 
top of the window and contains links for the actions you can perform in your role. The 
Dialog Panel (page 3) is the large frame occupying the remainder of the window.

In the Dialog Panel, you see the Welcome pages. The Welcome pages give you a brief tour of 
Rational Change.
 4



Using Help
Using Help
Report Builder help contains information about setting up and using Rational Change when 
you log on using the ReportBuilder role. Help is in HTML format and is designed to run on any 
platform using the supported browsers. Help uses frames to give you a fast and persistent way 
of finding information in the help system.
Your browser must be enabled to use cookies for Help to store and retrieve certain settings. If 
cookies are disabled, the Help system will not open with the last tab page you selected nor link 
to the Rational Synergy Web site.
Display context-sensitive help by clicking the Help link on the dialog box button bar. View a 
different topic in this help by clicking its link in the text, in the Contents page, or in the Index.

You can also display help by clicking the Help button in the Action Panel.
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Introduction
Contacting IBM Rational Software Support
If the self-help resources have not provided a resolution to your problem, you can contact 
IBM® Rational® Software Support for assistance in resolving product issues.

Note: If you are a heritage Telelogic customer, a single 
reference site for all support resources is located at http://
www.ibm.com/software/rational/support/telelogic/
 6
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Contacting IBM Rational Software Support
Prerequisites
To submit your problem to IBM Rational Software Support, you must have an active Passport 
Advantage® software maintenance agreement. Passport Advantage is the IBM 
comprehensive software licensing and software maintenance (product upgrades and technical 
support) offering. You can enroll online in Passport Advantage from http://www.ibm.com/
software/lotus/passportadvantage/howtoenroll.html

• To learn more about Passport Advantage, visit the Passport Advantage FAQs at http://
www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html.

• For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational Software Support, you 
must additionally:

• Be a registered user on the IBM Rational Software Support Web site. For details about 
registering, go to http://www.ibm.com/software/support/.

• Be listed as an authorized caller in the service request tool.
 7
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Introduction
Submitting problems
To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a problem to IBM, you 
are asked to supply a severity level. Therefore, you need to understand and assess the 
business impact of the problem that you are reporting.

Use the following table to determine the severity level.

2. Describe your problem and gather background information, When describing a problem to 
IBM, be as specific as possible. Include all relevant background information so that IBM 
Rational Software Support specialists can help you solve the problem efficiently. To save 
time, know the answers to these questions:

• What software versions were you running when the problem occurred?

To determine the exact product name and version, use the option applicable to you: 

- Start the IBM Installation Manager and select File > View Installed Packages. 
Expand a package group and select a package to see the package name and version 
number. 

- Start your product, and click Help > About to see the offering name and version 
number. 

• What is your operating system and version number (including any service packs or 
patches)? 

• Do you have logs, traces, and messages that are related to the problem symptoms? 
• Can you recreate the problem? If so, what steps do you perform to recreate the 

problem? 

Severity Description

1 The problem has a critical business impact: You are 
unable to use the program, resulting in a critical impact on 
operations. This condition requires an immediate solution.

2 This problem has a significant business impact: The 
program is usable, but it is severely limited.

3 The problem has some business impact: The program is 
usable, but less significant features (not critical to 
operations) are unavailable.

 4 The problem has minimal business impact: The problem 
causes little impact on operations or a reasonable 
circumvention to the problem was implemented.
 8



Contacting IBM Rational Software Support
• Did you make any changes to the system? For example, did you make changes to the 
hardware, operating system, networking software, or other system components? 

• Are you currently using a workaround for the problem? If so, be prepared to describe 
the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit your problem to 
IBM Rational Software Support in the following ways:

• Online: Go to the IBM Rational Software Support Web site at https://www.ibm.com/
software/rational/support/ and in the Rational support task navigator, click Open 
Service Request. Select the electronic problem reporting tool, and open a Problem 
Management Record (PMR), describing the problem accurately in your own words.

For more information about opening a service request, go to http://www.ibm.com/
software/support/help.html

You can also open an online service request using the IBM Support Assistant. For 
more information, go to http://www.ibm.com/software/support/isa/faq.html.

• By phone: For the phone number to call in your country or region, go to the IBM 
directory of worldwide contacts at http://www.ibm.com/planetwide/ and click the name 
of your country or geographic region. 

• Through your IBM Representative: If you cannot access IBM Rational Software 
Support online or by phone, contact your IBM Representative. If necessary, your IBM 
Representative can open a service request for you. You can find complete contact 
information for each country at http://www.ibm.com/planetwide/.
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Notices
© Copyright 2000, 2009
U.S. Government Users Restricted Rights - Use, duplication, or disclosure restricted by 
GSA ADP Schedule Contract with IBM Corp.
This information was developed for products and services offered in the U.S.A. IBM® may 
not offer the products, services, or features discussed in this document in other countries. 
Consult your local IBM representative for information on the products and services 
currently available in your area. Any reference to an IBM product, program, or service is 
not intended to state or imply that only that IBM product, program, or service may be used. 
Any functionally equivalent product, program, or service that does not infringe any IBM 
intellectual property right may be used instead. However, it is the user's responsibility to 
evaluate and verify the operation of any non-IBM product, program, or service. 
IBM may have patents or pending patent applications covering subject matter described in 
this document. The furnishing of this document does not grant you any license to these 
patents. You can send written license inquiries to: 

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A. 

For license inquiries regarding double-byte character set (DBCS) information, contact the 
IBM Intellectual Property Department in your country or send written inquiries to: 

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan 

The following paragraph does not apply to the United Kingdom or any other country 
where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS 
MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not 
allow disclaimer of express or implied warranties in certain transactions. Therefore, this 
statement may not apply to you. 
This information could include technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in new 
editions of the publication. IBM may make improvements and/or changes in the product(s) 
and/or the program(s) described in this publication at any time without notice. 
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Any references in this information to non-IBM Web sites are provided for convenience only 
and do not in any manner serve as an endorsement of those Web sites. The materials at 
those Web sites are not part of the materials for this IBM product and use of those Web 
sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it believes 
appropriate without incurring any obligation to you. 
Licensees of this program who wish to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created programs and 
other programs (including this one) and (ii) the mutual use of the information which has 
been exchanged, should contact: 

Intellectual Property Dept. for Rational® Software
IBM Corporation
1 Rogers Street
Cambridge, Massachusetts 02142
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including 
in some cases, payment of a fee. 
The licensed program described in this document and all licensed material available for it 
are provided by IBM under terms of the IBM Customer Agreement, IBM International 
Program License Agreement or any equivalent agreement between us. 
Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary significantly. 
Some measurements may have been made on development-level systems and there is 
no guarantee that these measurements will be the same on generally available systems. 
Furthermore, some measurements may have been estimated through extrapolation. 
Actual results may vary. Users of this document should verify the applicable data for their 
specific environment. 
Information concerning non-IBM products was obtained from the suppliers of those 
products, their published announcements or other publicly available sources. IBM has not 
tested those products and cannot confirm the accuracy of performance, compatibility or 
any other claims related to non-IBM products. Questions on the capabilities of non-IBM 
products should be addressed to the suppliers of those products.
This information contains examples of data and reports used in daily business operations. 
To illustrate them as completely as possible, the examples include the names of 
individuals, companies, brands, and products. All of these names are fictitious and any 
similarity to the names and addresses used by an actual business enterprise is entirely 
coincidental. 
If you are viewing this information softcopy, the photographs and color illustrations may 
not appear. 
     11



Copyright license
This information contains sample application programs in source language, which 
illustrate programming techniques on various operating platforms. You may copy, modify, 
and distribute these sample programs in any form without payment to IBM, for the 
purposes of developing, using, marketing or distributing application programs conforming 
to the application programming interface for the operating platform for which the sample 
programs are written. These examples have not been thoroughly tested under all 
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function 
of these programs. 
Each copy or any portion of these sample programs or any derivative work, must include a 
copyright notice as follows: 
© (your company name) (year). Portions of this code are derived from IBM Corp. (Sample 
Programs.) © Copyright IBM Corp. 2000 - 2009. 

Trademarks
See copyright notices on the Web at http://www.ibm.com/legal/copytrade.html.
Microsoft, Windows, and/or other Microsoft products referenced herein are either 
trademarks or registered trademarks of Microsoft Corporation.
UNIX is a registered trademark of The Open Group in the United States and other 
countries.
Other company, product or service names may be trademarks or service marks of others.
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Building reports
Use the Report Builder to design a report that contains all the information needed to track CRs, 
tasks, and objects.
Reports contain information about items in a selection set. When you define a report, you must 
define the query used to generate the selection set, choose the attributes to show for each 
selection set item, and define the report layout. You can also define relation reports, which show 
information about associated CRs, tasks, or objects.
After you have defined a report while in the ReportBuilder role, the report is displayed in the 
System folder in the Reports dialog box for users who logged in using the User interface. The 
format is also added to the System folder under the report name.
The main report definition operations are as follows:

• Building a report (page 14)

• Building relation reports (page 27)

• Installing reports (page 30)

For a detailed example, see Report Builder example (page 31).
 13



Building reports
Building a report
The following steps summarize how to build reports using the Report Builder. You must 
perform the steps in the order shown to avoid errors.

1. Plan the report.

For example, based on the CR Process you are using, determine whether you are 
reporting on CRs, tasks, or objects, decide which attributes to choose for the report, and 
decide which, if any, values you want calculated for you. You need to define the specific 
information you want in the report in order to define the components of the report. 

For example, you must determine if you need a subreport or a relation report. Subreports 
and relation reports are similar, in that both allow you to look up an item related to the 
context item. For instance, if the context item is a CR, you might want to look up its 
associated tasks. Subreports and relation reports differ in several ways:

• Defining a relation report is very similar to defining a top-level report, except that it 
does not have a separate query or a main template. A subreport, on the other hand, 
has its own query that references the context item. It is actually a separate report that 
was previously defined. It is merely included inside another report. 

• Relation reports can be chained together in a linear fashion. That is, each item can 
show a single related item. Subreports enable reporting on multiple related items. This 
is done by including multiple subreports for the context item. 

So, if you wanted to show a CR and its tasks, both relation reports and subreports can do 
the job. However, to show a CR with its tasks and attachments, you would need to use a 
subreport, because the relation report can only show one or the other (the tasks or the 
attachments, but not both at the same time). 

2. Starting Rational Change sessions (page 4).

3. Install a process package, if you have not done so already.

A process package contains the list of reportable attributes for a CR Process. Unless you 
install one of these packages, your attribute list will be empty. Admin Help.

4. On the Action Panel, click Report Builder.
The Report Builder dialog box appears, with the Select Report File subdialog box 
displayed.

5. Select a report name, or create a new report by typing a new report name.

To change an existing report, click a report name in the Available Report Files list, and 
then click Edit.
To define a new report, type a new report name in the New Report File box (including the 
xml file name extension), and then click Create. 
 14



Building a report
If you do not type a file name, Rational Change creates a report named csReportX.xml, 
where XX is a number incremented whenever Rational Change creates a report using an 
existing report name.

6. Define the query that will generate the selection set of CRs, tasks, or objects on which you 
are reporting.

For steps, see Defining queries (page 16).

7. Defining general report properties (page 17). The report name you type appears in users’ 
System report and format lists.

8. Selecting templates to include (page 18) on the report.

9. Defining headers (page 19), which is the information that will appear at the top of the 
report page.

10. Defining report bodies (page 20), which is the information that will appear in the body of 
the report.

11. Defining footers (page 22), which is the information that will appear at the bottom of the 
report page.

12. Adding charts to reports (page 23) that will appear at the bottom of the report.

13. Defining grouping (page 24). Groupings create sections on the report based on an 
attribute value. You can also define a graphic for each grouping.

14. Defining sorting (page 26). Sorting determines the order that the items appear in the 
report.

Note Sorting is always applied after grouping; therefore, the 
attribute selected for grouping never appears in the sorting lists.

15. Building relation reports (page 27) (optional).

If your selection set contains items that have associated items (such as CRs with 
associated tasks), you can define a relation report that will show the associated items.

16. Installing reports (page 30).

For a detailed example, see Report Builder example (page 31).
 15



Building reports
Defining queries
You must define a query for the content of the report.

1. In the Report Builder dialog box, click Define Query.

The Define Query dialog box appears.

2. Choose query criteria.

Select an operand, operator, and value, and the appropriate buttons. Repeat these steps 
until your query is completed. You can also type the entire query, or parts of the query, into 
the Query String box.

3. Click Update.

Related Topics

• Defining queries (example) (page 33)
 16



Building a report
Defining general report properties
You must define the general report properties, including the report name and what type of 
objects will be shown in the report.

1. In the Report Builder dialog box, click Properties.

2. Click the General tab.

3. Define the general report properties.

a. In the Name box, type a report name.

Make the name meaningful because the name will be listed in System reports and 
formats.

b. In the Type list, click Change Request, Task, or Object. This selection determines 
the content of the Reportable Attributes list.

c. In the Style list, click Block or Column.

d. In the Format list, click the format for the generated report.

e. In the Description box, type a description of the report.

4. Set up paging (optional).

a. Select the Paging check box.

Clear the Paging check box if you intend to print the report or use it for bulk 
transitioning; otherwise, you will have to print the report or transition the CRs one page 
at a time.

b. In the Items Per Page, type the number of items.

5. If you want to include a reload button on HTML reports, click Reload button.

6. In the Query Limit box, type the maximum number of items to find. If the query result 
exceeds this limit, the report is stopped.

7. In the String Limit, type the maximum string length of a reported attribute value. Attribute 
values that exceed this limit are truncated.

8. In the Reportable Attributes list, select the attributes to display on the report.

The problem_number, problem_synopsis, and problem_description attributes are 
included automatically in the Attributes in Report list when you create a new report.

For information about arranging and setting the attributes, see Admin Help.

9. Click Update.

Related Topics

• Defining general properties (example) (page 35)
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Building reports
Selecting templates to include
You must choose the templates you will use to construct the report. The templates represent 
different report elements, such as the header, body, and footer.

1. In the Report Builder dialog box, click Properties.

2. Click the Main tab.

3. Select templates to include on the report.

a. Select the Include Header Template check box to display a header at the top of the 
report.

b. Select the Include Attribute Template check box to define the body of the report.

c. Select the Include Footer Template check box to display a footer at the bottom of the 
report.

d. Select the Include Image Template check box to display a charting graphic at the 
bottom of the report.

4. Click Update.

Related Topics

• Selecting templates to include (example) (page 37)
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Building a report
Defining headers
Define the header if you want to include a header in the report.

1. In the Report Builder dialog box, click Properties.

2. Click the Header tab.

3. Define the header layout.

a. Select the Title check box if you want to show the report title.

The Title is the name the user gives the report before running it.

b. Select the Date check box if you want to show the date.

c. Select the Object Count check box if you want to show the number of reported items.

d. Select the Report Name check box if you want to show the name of the report.

e. Select the Query Name check box if you want to show the name of the query.

f. Select the Query String check box if you want to show the query string.

4. Define header metric operations (optional).

a. In the Metric Operations area, click Add.

The Available Metric Operations Definition subdialog box appears.

b. In the Select a Metric Type list, click Column or Row & Column.

c. In the Select a Metric Operation list, click a metric operation.

The XXX Metric area appears under Available Metric Operations.

Define the metric. For more information, see Metric operations explained (page 54).

d. In the metrics definition area, click Create.

5. Under the Layout area, click Update.

Related Topics

• Defining headers (example) (page 38)
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Building reports
Defining report bodies
Define the report body, unless you want to show only a graphic.

1. In the Report Builder dialog box, click Properties.

2. Click the Attribute tab.

3. Define the body layout.

a. In the Number of Columns box, type the number of columns to use on the report.

b. Select the Include Border check box to include borders around attribute/value pairs 
on the report.

c. Select the Include Bulk Operations check box to allow users to transition multiple 
items on the report.

4. Define subreports (optional).

A subreport shows a selection of set of objects obtained from a previously defined report. 
Typically, the objects are attachments (unlike relation report objects, for which the objects 
are CRs, tasks, or objects). For more information about when to use subreports, see 
Building a report (page 14).

a. Under the Subreports Included on Attribute Template list, click Add.

The Add Subreport subdialog box appears.

b. Click Change Request, Task, or Object, depending on what type of subreport you 
want to run.

This action sets the Select Report list to the correct choices.

c. In the Select Report list, click the report to run.

The Define Query dialog box appears.

d. In the Define Query subdialog box, create the query for the subreport.

Be sure to include a keyword for the type of object for which the report is run. For 
example, include %problem_number, %task_number, or %cvid in the query string to 
run reports for each CR, task, or object, respectively.

5. Define body metric operations (optional).

a. In the Metric Operations area, click Add.

The Available Metric Operations Definition subdialog box appears.

b. In the Select a Metric Type list, click Row.

c. In the Select a Metric Operation list, click a metric operation.

The XXX Metric area appears under Available Metric Operations.

Define the metric. For more information, see Metric operations explained (page 54).
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Building a report
d. In the metrics definition area, click Create.

6. Under the Layout area, click Update.

Related Topics

• Defining bodies (example) (page 40)
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Building reports
Defining footers
Define the footer if you want to include a footer in the report.

1. In the Report Builder dialog box, click Properties.

2. Click the Footer tab.

3. Define the footer layout.

a. Select the Title check box if you want to show the report title.

The Title is the name the user gives the report before running it.

b. Select the Date check box if you want to show the date.

c. Select the Object Count check box if you want to show the number of reported items.

d. Select the Report Name check box if you want to show the name of the report.

e. Select the Query Name check box if you want to show the name of the query.

f. Select the Query String check box if you want to show the query string.

4. Define footer metric operations (optional).

a. In the Metric Operations area, click Add.

The Available Metric Operations Definition subdialog box appears.

b. In the Select a Metric Type list, click Column or Row & Column.

c. In the Select a Metric Operation list, click a metric operation.

The XXX Metric area appears under Available Metric Operations.

Define the metric. For more information, see Metric operations explained (page 54).

d. In the metrics definition area, click Create.

5. Under the Layout area, click Update.

Related Topics

• Defining footers (example) (page 42)
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Building a report
Adding charts to reports
Define the image template if you want to include a chart in the report.

1. In the Report Builder dialog box, click Properties.

2. Click the Image tab.

3. Under Layout, click Add.

The temporary chart name, _New_Chart, appears in the subdialog Charts Included in 
Report box.

4. Define the chart.

a. In the Title box, select the _New_Chart string, and then type the chart name.

The title appears in the Charts Included in Report list.

b. In the Type list, click a chart type.

c. In the Tool list, click a tool.

d. In the Attribute list, click the attribute to chart.

e. In the 2ND Attribute list, click the attribute to chart, if required.

f. In the Width in Pixels box, type the graphic width, or accept the default value.

g. In the Height in Pixels box, type the graphic height, or accept the default value.

5. Click Update.

Related Topics

• Adding charts to reports (example) (page 43)
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Building reports
Defining grouping
Define attribute grouping if you want the report results to be grouped.

1. In the Report Builder dialog box, click Properties.

2. Click the Grouping tab.

3. Define the grouping layout.

a. In the Group By list, click the attribute by which to group. For example, if you query for 
CRs and group using the product_name attribute, CRs with the same product name 
are grouped on the report.

b. Select the Include Grouping Count check box if you want to show the number of 
items in the group on the report.

c. Select the Include Grouping Value check box if you want to show the attribute used 
to group the results on the report.

4. Select or create charts for the group (optional).

Select one or more charts, or add a chart by performing the following steps:

a. Under Charts Included on Grouping Template, click Add.

The Grouping Chart Layout subdialog box appears.

The temporary chart name, _New_Chart, appears in the subdialog Charts Included in 
Report box.

b. In the Title box, select the _New_Chart string, and then type the chart name.

c. In the Tool list, click a tool.

d. In the Attribute list, click the attribute to chart.

e. In the 2ND Attribute list, click the attribute to chart, if required.

f. In the Width in Pixels box, type the graphic width, or accept the default value.

g. In the Height in Pixels box, type the graphic height, or accept the default value.

h. Click Update.

The chart title appears in the Charts Included On Grouping Template list.

5. Define grouping metric operations (optional).

a. In the Metric Operations area, click Add.

The Available Metric Operations Definition subdialog box appears.

b. In the Select a Metric Type list, click Column or Row & Column.

c. In the Select a Metric Operation list, click a metric operation.

The XXX Metric area appears under Available Metric Operations.

Define the metric. For more information, see Metric operations explained (page 54).
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Building a report
d. In the metrics definition area, click Create.

6. Under the Layout area, click Update.

Related Topics

• Defining groupings (example) (page 44)
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Building reports
Defining sorting
Define attribute sorting if you want the report results to be sorted.

1. In the Report Builder dialog box, click Properties.

2. Click the Sorting tab.

3. Choose the order in which items appear on the report, based on the values of up to three 
attributes.

Note The grouping attribute takes precedence over the 
attributes selected on this tab.

a. In the Attribute list, click an attribute.

b. In the Sort Type list, click the type of the attribute.

c. In the Direction list, click Ascending or Descending order (for example, click 
Ascending to list items in increasing order by attribute value).

Related Topics

• Defining sorting (example) (page 45)
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Building relation reports
Building relation reports
A relation report definition determines the layout and content of information reported for 
associated CRs, tasks, or objects. Relation Reports are “embedded” in reports, following the 
parent CRs with which they are associated.

Note The Main and Grouping tabs are not available for relation 
reports. Also, relation reports do not have their own queries.

1. Display the Report Builder dialog box.

2. Defining relation reports (page 28).

3. In the Report list, click the relation report name.

4. Defining general relation report properties (page 29).

5. Defining headers (page 19), which is the information that will appear at the top of each 
relation report.

6. Defining report bodies (page 20), which is the information that will appear in the body of 
the relation report.

7. Defining footers (page 22), which is the information that will appear at the bottom of each 
relation report.

8. Adding charts to reports (page 23), which will appear at the bottom of the relation report.

9. Defining sorting (page 26). Sorting determines the order that the items appear in the 
report.

10. The report is ready to install. See Installing reports (page 30).
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Defining relation reports
Define a relation report if you want to generate a report for associated objects.

1. On the subbutton bar, click Add Relation Report.
The Define a Relation Report dialog box appears.

2. In the Report Name box, type the relation report name.

3. In the Report Type list, click Change Request, Task, or Object. 
4. Specify a relation. In the Select Existing Relations list, click the relation report items’ 

relationship to the parent item. Associated Tasks, Attachments, and Duplicate of are 
shipped relations. You can create additional relations by creating relation attributes in the 
CR Process. The relation appears in the Report Relation box.

Or, type the relation name in the Report Relation box. For additional information on 
relation types you can type in, see Rational Synergy Help for the relate command.

5. Click Update.

Related Topics

• Building relation reports (example) (page 46)
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Building relation reports
Defining general relation report properties
Define the general relation report properties, including the relation report name and what type 
of objects will be shown in the report.

1. In the Reportable Attributes list, select the attributes to display on the relation report.

For information about arranging and setting the attributes, see Admin Help.

2. Click Update.

Related Topics

• Defining general relation report properties (example) (page 48)
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Installing reports
Before anyone can use a system report, you must create and install the package for the report.
To install a report:

1. On the subbutton bar, click Save.

2. On the subbutton bar, click Uninstall to uninstall any previous version of this report.

This operation removes the report package from the Installed Packages list on the 
Package Installer tab.

3. On the button bar, click Install.
This operation adds the report package to the list of installed packages, and to the user list 
of System reports and formats.

Related Topics

• Saving and Installing reports (example) (page 51)
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Report Builder example
The following procedures show how to build a CR report, with task relation reports, for all 
resolved CRs with  hammer, saw, and drill product names. The CRs will be grouped by 
product name, then sorted by request type. This example uses the dev_process that is 
shipped with the product.
To try this example, you must do the following:

1. Add hammer, saw, and drill values to the product_name list box attribute.

For information about setting the attributes, see Admin Help.

2. Create CRs using the hammer, saw, and drill product names.

3. Create associated tasks for some of the CRs.

4. Complete the associated tasks.

5. Set the completed dates for the CRs.

6. Transition the CRs to the resolved state.

Related Topics

• Building the report (example) (page 32)

• Building relation reports (example) (page 46)

• Saving and Installing reports (example) (page 51)
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Building the report (example)
Define the report for the CRs.

1. Starting Rational Change sessions (page 4).

2. Install a process package, if you have not done so already.

For example, install the dev_process CR Process. For more information, see Admin Help.

3. On the Action Panel, click Report Builder.
The Report Builder dialog box appears, with the Select Report File subdialog box 
displayed.

4. Create the report name.

Type a new report name in the New Report File box (including the xml file name 
extension), and then click Create.

5. Defining queries (example) (page 33).

6. Defining general properties (example) (page 35).

7. Selecting templates to include (example) (page 37).

8. Defining headers (example) (page 38), which is the information that will appear at the top 
of the report.

9. Defining bodies (example) (page 40), which is the information that will appear in the body 
of the report.

10. Defining footers (example) (page 42), which is the information that will appear at the 
bottom of the report.

11. Adding charts to reports (example) (page 43).

12. Defining groupings (example) (page 44).

13. Defining sorting (example) (page 45).

14. Building relation reports (example) (page 46).

15. To deploy the report being created, see Saving and Installing reports (example) (page 51).
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Report Builder example
Defining queries (example)
Define a query for resolved CRs with product name hammer, saw, or drill.
1. In the Report Builder dialog box, click Define Query.

The Define Query dialog box appears.

2. Choose query criteria.

Find all resolved CRs for the hammer, saw, and drill products. 

Select an operand, operator, and value, and the appropriate buttons. Repeat these steps 
until your query is completed. You can also type the entire query, or parts of the query, into 
the Query String box. Your query string should be:

(cvtype=’problem’)

and

((product_name='drill') or (product_name='hammer') or 
(product_name='saw'))

and

(crstatus=’resolved’)

 

3. Click Update.

The following figure shows the query definition.
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Defining general properties (example)
Define the general report properties, including specifying that the report is for change requests 
and will be in an HTML format.

1. In the Report Builder dialog box, click Properties.

2. Click the General tab.

3. Define the general report properties.

a. In the Name box, type Resolved CRs for hardware.

b. In the Type list, click Change Request.
c. In the Style list, click Block.

d. In the Format list, click HTML.

e. In the Description box, type a description of the report; for example, Report on all 
resolved CRs for hammer, saw, and drill products.

4. Select the Reload button checkbox, so that a reload button appears on HTML reports.

5. Accept the default values for the Query Limit and String Limit.
6. In the Reportable Attributes list, select the attributes to display on the report.

You will select Include Border on the Attribute tab; therefore, you need not insert lines 
between attributes.

The CR ID, Synopsis, and Description attributes are included automatically in the 
Chosen Attributes list when you create a new report.

Also add the following attributes:

Entered Date
Resolution Date
Request Type
Severity
Product Name
Resolver
Select the Span Column check box for problem_synopsis and problem_description.

7. Click Update.

The following figure shows the general properties definition.
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Selecting templates to include (example)
Include a header, footer, body, and image on the report.

1. In the Report Builder dialog box, click Properties.

2. Click the Main tab.

3. Select templates to include on the report.

a. Select the Include Header Template check box.

b. Select the Include Attribute Template check box.

c. Select the Include Footer Template check box.

d. Select the Include Image Template check box.

4. Click Update.

The following figure shows the included templates definition.
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Building reports
Defining headers (example)
Include a title, date, object count, and report name in the header.

1. In the Report Builder dialog box, click Properties.

2. Click the Header tab.

3. Define the header layout.

a. Select the Title check box.

b. Select the Date check box.

c. Select the Object Count check box.

d. Select the Report Name check box.

4. Define the header metric operation for computing the average time, in minutes, to resolve 
a CR.

a. In the Metric Operations area, click Add.

The Available Metric Operations Definition subdialog box appears.

b. In the Select a Metric Type list, click Row & Column.

c. In the Select a Metric Operation list, click Average of Differences.

The Row & Column Average of Differences Metric area appears under Available 
Metric Operations.

d. In the Label box, type Average Time to Resolve.

e. In the Find the Difference of list, click resolution_date.

f. In the minus list, click entry_date.

g. In the Data Type list, click Date.

h. In the Date Unit list, click Minutes.

i. In the metrics definition area, click Create.

5. Under the Layout area, click Update.

The following figure shows the header definition.
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Building reports
Defining bodies (example)
In the body, show how much time is required to resolve CRs.

1. In the Report Builder dialog box, click Properties.

2. Click the Attribute tab.

3. Define the body layout.

a. In the Number of Columns box, accept the default value (2).

b. Select the Include Border check box to include borders around attribute/value pairs 
on the report.

c. Clear the Include Bulk Operations check box, if set.

In this example, the CRs for the report are already resolved.

4. Define the body metric operation. For more information about metrics, see Metric 
operations explained (page 54).

a. In the Metric Operations area, click Add.

The Available Metric Operations Definition subdialog box appears.

b. In the Select a Metric Type list, click Row.

c. In the Select a Metric Operation list, click Difference.

The Row Difference Metric area appears under Available Metric Operations.

d. In the Label box, type Time to Resolve.

e. In the Find the Difference of list, click resolution_date.

f. In the minus list, click entry_date.

g. In the Data Type list, click Date.

h. In the Date Unit list, click Minutes.

i. In the metrics definition area, click Create.

5. Under the Layout area, click Update.

The following figure shows the body definition.
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Building reports
Defining footers (example)
Include the query name and query string in the footer.

1. In the Report Builder dialog box, click Properties.

2. Click the Footer tab.

3. Define the footer layout.

a. Select the Query Name check box to show the name of the query.

b. Select the Query String check box to show the query string.

4. Click Update.

The following figure shows the footer definition.
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Adding charts to reports (example)
Include a chart that shows the number of resolved CRs for each product.

1. In the Report Builder dialog box, click Properties.

2. Click the Image tab.

3. Under Layout, click Add.

The temporary chart name, _New_Chart, appears in the subdialog Charts Included in 
Report box.

4. Define the chart.

a. In the Title box, select the _New_Chart string, and then type All hardware.

b. In the Type list, click Pie Chart.
c. In the Attribute list, click product_name to create the chart products.

d. In the Width in Pixels and Height in Pixels boxes, accept the default values (400 
pixels).

5. Click Update.

The following figure shows the image definition.
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Building reports
Defining groupings (example)
Group the results by product name.

1. In the Report Builder dialog box, click Properties.

2. Click the Grouping tab.

3. Define the grouping layout.

a. In the Group By list, click product_name.

b. Select the Include Grouping Count check box.

c. Select the Include Grouping Value check box.

4. Click Update.

The following figure shows the grouping definition.
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Defining sorting (example)
Sort the results by request type (after the results have been grouped).

1. In the Report Builder dialog box, click Properties.

2. Click the Sorting tab.

3. Choose the order in which items appear on the report.

a. In the Attribute list, click request_type.

b. In the Sort Type list, click String or listbox to maintain the listbox order.

c. In the Direction list, click Ascending to list items alphabetically by product name.

The following figure shows the sorting definition.
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Building relation reports (example)
Define the relation report for the associated tasks.

1. Display the Report Builder dialog box.

2. Defining relation reports (example) (page 47).

3. In the Report list, click the relation report name.

4. Defining general relation report properties (example) (page 48).

5. Defining relation report headers (example) (page 49), which is the information that will 
appear at the top of each relation report.

6. Define the information that will appear in the body of the relation report.

For steps, see Defining relation report bodies (example) (page 50).
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Defining relation reports (example)
Define a relation report that shows associated tasks.

1. On the subbutton bar, click Add Relation Report.
The Define a Relation Report dialog box appears.

2. In the Report Name box, type Associated Tasks.

3. In the Report Type list, click Task.

4. In the Existing Relations list, click Associated Tasks.

The relation appears in the Report Relation box.

5. Click Update.

The following figure shows the relation report general properties definition.
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Defining general relation report properties (example)
Define the general properties of the relation report, including the task attributes to show.

1. In the Report list, click the new relation report name.

The General tab appears. The Relation Report Properties are defined already.

2. In the Reportable Attributes list, select the attributes to display on the relation report.

Add the following attributes:

Task ID
Status
Assignment Date
Completion Date

3. Click Update.

The following figure shows the relation report general properties definition.
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Defining relation report headers (example)
Include a title, date, object count, and report name in the header.

1. In the Report list, click the new relation report name.

2. In the Report Builder dialog box, click Properties.

3. Click the Header tab.

4. Define the header layout.

a. Select the Title check box.

b. Select the Date check box.

c. Select the Object Count check box.

d. Select the Report Name check box.

5. Click Update.

The following figure shows the relation report header definition.
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Building reports
Defining relation report bodies (example)
Define the layout for showing the tasks. 

1. In the Report list, click the new relation report name.

2. In the Report Builder dialog box, click Properties.

3. Click the Attribute tab.

4. Select Include border.
5. Click Update to save the settings.
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Saving and Installing reports (example)
Before anyone can use the custom report, you must create a package for the report, and then 
install it.

1. On the button bar, click Save.

2. On the button bar, click Install.
This operation adds the report package to the list of installed packages, and to users’ lists 
of System reports and formats.

3. Run the report.

a. Start a session as a user.

b. On the Action Panel, click Reports.

c. In the Reports folder, click System.

d. In the System report list, click the new report, then click Run.

e. View the report.

The following figures show the top and bottom of a custom report generated using this 
procedure.
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More reporting information
Metric operations explained
Metric operations are computations performed with attribute values. The results of the 
computations, or metrics, are included in your report.
Metric operation options are available only on the Header, Footer, Attribute, and Grouping 
tabs.
The metric operation type is either Row or Row & Column. Rational Change performs Row 
operations on the specified attributes of each item (CR, task, or object) in a selection set, and 
performs Row & Column operations first on each item attributes, then across all items.
The following table shows a Rows and Columns example for a set of tasks The last column, 
Attribute_M, represents the amount of time required to complete the task.

The following are examples of Row and Row & Column metric operations based on the above 
table:

• Difference (Row)

Compute the time to complete a task -- the difference between the assigned date/time 
(Assigned Date) and completion date/time (Completion Date) for each task.

• Maximum (Column)

Determine which task was completed last -- had the latest completion date (Attribute 3).

• Average of Differences (Row & Column)

Compute the average time to complete all tasks -- differences between Attribute 3 and 
Attribute 2, then averaged)

The list of available metric operations depends on which tab is displayed. Header and Footer 
tabs define the content of sections at the top and bottom of each report, for all items in the 
report; therefore, Column and Row & Column metric operations are available on these tabs 
because they are performed across all items. The Attribute tab defines content for the body of 
the report, where each item is listed individually; therefore, only Row metric operations are 
available on this tab. The Grouping tab defines item groupings based on their attribute values; 
therefore, Column and Row & Column metric operations are available on this tab.

Header and Footer tabs can group metric operations, thus spanning rows. An Attribute tab 
looks at individual rows only.

Item Attribute 1 Attribute 2 Attribute 3 ... Attribute_M

1 Task # 1 Assigned Date 1 Completion Date 1 ... attribute_M 1

2 Task # 2 Assigned Date 2 Completion Date 2 ... attribute_M 2

... ... ... ... ... ...

N Task # N Assigned Date N Completion Date N ... attribute_M N
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Metric operations explained
Note If the attributes do not exist for the computation you want 
to perform, you must define the attributes and make them 
reportable in your CR Process; save, create, and install the 
updated CR Process; and then add the attributes to the 
Attributes in Report list on the Report Builder General tab.

The Report Builder has more than 30 metric operations. For more information about these 
operations, see the “PTReport” Wslets section in the IBM Rational Change Customization 
Reference.
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actions

Exit 3
Help 3
Home 3
Report Builder 3

attachments used in reports 20
attributes, setting 17

B
building reports 13
bulk transitions, allowing 20

C
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in subreports 20
reports for 17

charts, using in reports 23
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D
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E
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in subreports 20
reports for 17

ordering report contents 26
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Q
query, defining for subreports 20

R
relation reports
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relationships, defining 28
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adding to list of available 30
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